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Legal information 
Use of application examples 

Application examples illustrate the solution of automation tasks through an interaction of several 
components in the form of text, graphics and/or software modules. The application examples are 
a free service by Siemens AG and/or a subsidiary of Siemens AG (“Siemens”). They are non-
binding and make no claim to completeness or functionality regarding configuration and 
equipment. The application examples merely offer help with typical tasks; they do not constitute 
customer-specific solutions. You yourself are responsible for the proper and safe operation of the 
products in accordance with applicable regulations and must also check the function of the 
respective application example and customize it for your system. 
Siemens grants you the non-exclusive, non-sublicensable and non-transferable right to have the 
application examples used by technically trained personnel. Any change to the application 
examples is your responsibility. Sharing the application examples with third parties or copying the 
application examples or excerpts thereof is permitted only in combination with your own products. 
The application examples are not required to undergo the customary tests and quality inspections 
of a chargeable product; they may have functional and performance defects as well as errors. It is 
your responsibility to use them in such a manner that any malfunctions that may occur do not 
result in property damage or injury to persons. 
 

Disclaimer of liability 
Siemens shall not assume any liability, for any legal reason whatsoever, including, without 
limitation, liability for the usability, availability, completeness and freedom from defects of the 
application examples as well as for related information, configuration and performance data and 
any damage caused thereby. This shall not apply in cases of mandatory liability, for example 
under the German Product Liability Act, or in cases of intent, gross negligence, or culpable loss of 
life, bodily injury or damage to health, non-compliance with a guarantee, fraudulent 
non-disclosure of a defect, or culpable breach of material contractual obligations. Claims for 
damages arising from a breach of material contractual obligations shall however be limited to the 
foreseeable damage typical of the type of agreement, unless liability arises from intent or gross 
negligence or is based on loss of life, bodily injury or damage to health. The foregoing provisions 
do not imply any change in the burden of proof to your detriment. You shall indemnify Siemens 
against existing or future claims of third parties in this connection except where Siemens is 
mandatorily liable. 
By using the application examples you acknowledge that Siemens cannot be held liable for any 
damage beyond the liability provisions described. 
 

Other information 
Siemens reserves the right to make changes to the application examples at any time without 
notice. In case of discrepancies between the suggestions in the application examples and other 
Siemens publications such as catalogs, the content of the other documentation shall have 
precedence.  
The Siemens terms of use (https://support.industry.siemens.com) shall also apply.  
 

Security information 
Siemens provides products and solutions with industrial security functions that support the secure 
operation of plants, systems, machines and networks. 
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. 
Siemens’ products and solutions constitute one element of such a concept. 
Customers are responsible for preventing unauthorized access to their plants, systems, machines 
and networks. Such systems, machines and components should only be connected to an 
enterprise network or the internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place. 
For additional information on industrial security measures that may be implemented, please visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats. 
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
under https://www.siemens.com/cert. 

https://support.industry.siemens.com/
https://www.siemens.com/industrialsecurity
https://www.siemens.com/cert
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1 Introduction 
With Multiuser Engineering in TIA Portal, you can work on a project with multiple 
users simultaneously. By processing different objects in parallel within a multi-user 
server project, you can significantly shorten project planning and commissioning 
times. 

1.1 Overview  

TIA Portal provides you with various server constellations for the functionality of 
Multiuser Engineering. This application example describes the parallel handling of 
projects with a project server; the server's functionality is implemented on a 
dedicated server. The multi-user server projects are also stored on the dedicated 
server.  

In order to be able to work simultaneously with several agents in a server project 
within the framework of Multiuser Engineering, each agent must create their own 
local session. In the local session, the respective editor can insert his changes and 
then check these changes into the server project and publish them. After check-in, 
the changes from the local session are available again to all editors in the server 
project. 

In addition to Multiuser Engineering, Multiuser Commissioning allows you to carry 
out joint commissioning in a team just as conveniently. 

Working with Exclusive Engineering allows you to conveniently work on your 
project as a "single user", but with all the advantages that the TIA Project-Server 
offers. 

 

The following figure shows the server constellation "Project server as dedicated 
server".  

Figure 1-1: "Project server as dedicated server" server constellation 
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Project server advantages 

• A common project is stored centrally on a server. 

• Use project revisions for temporary backups and for archiving project 
milestones; comment functionality and rollback to older project revisions are 
also supported. 

• Change history provides information about edited projects (exportable for 
further detailed evaluations). 

• Backward compatibility of the project server (one server for all projects) 
enables mixed operation between TIA Portal and server versions. 

Advantages of Multiuser Engineering and Multiuser Commissioning 

• Joint engineering and commissioning in a team. 

• System-supported synchronization during engineering reduces the 
coordination effort in the team. 

• Consistency between server project and PLC guaranteed with Commissioning 
Mode. 

• No overwriting of changes in the PLC by other operators.  

• Multiuser Engineering can be used with the local project server without a 
license. 

Advantages of Exclusive Engineering 

• Optimized workflows for editing projects. 

• No multi-user license required for Exclusive Engineering. 

 

Note Further server constellations can be found in the TIA Portal V17 online help or in 
the system manual "SIMATIC STEP 7 Basic/Professional V17 and SIMATIC 
WinCC V17": 

https://support.industry.siemens.com/cs/ww/en/view/109798671 

https://support.industry.siemens.com/cs/ww/en/view/109798671
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1.2 Components used 

The following hardware and software components were used to create this 
application example:  

Table 1-1: Hardware and software components 

Component Quantity Item number Note 

SIMATIC Field PG 3 6ES7717-.....-0... or PC with  
TIA Portal V17 

STEP 7 Professional V17 3 6ES7822-1..07-.. - 

WinCC Advanced V17 3 6AV210.-....7-0 - 

TIA Portal Multiuser 
Engineering V17 

3 6ES7823-1A.0.-.Y.. - 

SCALANCE  1 - or switch 
1 gigabit network 

 

This application example consists of the following components:  

Table 1-2: Components 

Component File name Note 

Documentation 109740141_MultiUser_Engineering_DOC_v15_en.pdf - 
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2 Engineering  

2.1 Hardware setup  

The following figure shows the hardware setup of the application. In this application 
example, the workstations are connected via a switch in an office network.  

 

Figure 2-1: Hardware setup 

TIA Portal
Local session

Project server

Client 1 Client 2

Server projects

TIA Portal
Local session

 

 

Note When installing TIA Portal products on the different clients, make sure that the 
same TIA Portal software products with identical output statuses are installed on 
all engineering systems used. 

 

Note In order to be able to work with Multiuser Engineering, a network must already 
be set up taking Windows settings, IP addresses, firewalls, etc. into account. 

The network can also be located within a Windows domain. 
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2.2 Configuration 

2.2.1 Create user accounts for clients on the project server PC 

For the office network described in Figure 2-1, you can create the user accounts for 
the clients locally on the project server. The accounts must be identical to the 
accounts of the clients. With this procedure, the server can automatically 
authenticate a local client account with identical login data to an existing server 
account. 

You can create the accounts on the project server in the Windows Control Panel. In 
Windows 10, proceed as follows: 

1. In the Control Panel, click on "User Accounts > Manage another account > Add 
a new user in PC settings > Add someone else to this PC". 

2. Choose "I don't have this person's sign-in information". 

3. Choose "Add a user without a Microsoft account". 

4. Enter the user name of the client, e.g. "MultiuserClient1". 

5. Assign a password and confirm it. 

6. Click "Next" to confirm your entries. 

 

Figure 2-2: Create new account 

 

The new account is created as the default user. 
 

7. Repeat steps 1 through 6 for the accounts of other clients. 
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Note If the server and clients are members of the same Windows domain, the server 
and clients must use the same LAN and be created on the domain controller.  

If the server and the clients are in the same Windows domain, you do not need 
to create the clients' accounts on the project server. 

Further information can be found in the TIA Portal V17 online help or in the 
system manual "SIMATIC STEP 7 Basic/Professional V17 and SIMATIC WinCC 
V17": 

https://support.industry.siemens.com/cs/ww/en/view/109798671 

 

Note The users still have to be assigned the appropriate permissions in the user 
administration of the TIA Project-Server Administration Tools. 
(see chapter 2.2.5.2) 

 

2.2.2 Install TIA Project-Server 

You can install the project server together with TIA Portal. You can also install the 
project server standalone, without TIA Portal. 

Note A description of the automated installation can also be found on the product 
DVD. 

The tools for configuring and managing the project server are now available in all 
TIA Portal languages. 

The various versions of the project server can be used side by side on one 
device. The current project server also supports older TIA Portal projects, with 
corresponding functionality.  

New project server functions are only available if the new TIA Portal is installed. 

To work in a local session, you need a valid multi-user license for each local 
session. 

 

https://support.industry.siemens.com/cs/ww/en/view/109798671
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2.2.3 Install a newer TIA Project-Server without losing data 

Make sure to first install the newer project server and then to uninstall the older 
version of the project server. 

Use this procedure to ensure that the user authorizations that exist for the server 
can also be transferred to the new server. If all existing project servers are 
completely deleted before the new installation, the user settings are also lost and 
must be recreated. 

 

If you want to replace an older version of the project server with a newer version 
and not lose your data, proceed as follows: 

1. Stop the service for the "old" project server in the Configuration Tool. 

2. Start the installation setup for the new project server by double-clicking on the 
self-extracting .exe file "TIA_Portal_Projekt_Server_V<x.y>.exe" located in the 
"Support" folder on the respective project DVD. 

3. Select the desired settings and click "Install". 

4. Follow the instructions in the setup dialogs. 

5. Configure the newly installed project server in the Configuration Tool and 
select the same save folder that is used in the existing project server. 

6. Temporarily assign a new port for the newly installed project server. 

7. In the Configuration Tool, install the service for the new project server. 

8. Now uninstall the service for the existing project server in the Configuration 
Tool.  

9. Then uninstall the existing project server with the "Add or remove programs" 
function.  

10. Reconfigure the port assigned earlier for the existing project server. 

11. Start the service for the newly installed server in the Configuration Tool. 

12. You can now continue working with the newly installed project server without 
any further changes in TIA Portal. 
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2.2.4 Configure the TIA Project-Server 

You can configure the project server with the graphical tool "TIA Project-Server 
V17 - Configuration".  

Follow the steps below: 

1. Open the Start menu by clicking "Start > All Programs > Siemens Automation". 
Click "TIA Project-Server V17 - Configuration" to open the configuration tool. 

2. Enter the desired data. 

Select "https" for secure communication and the port. 

If you are using an https connection, you can create a new certificate or use an 
existing one in the "Security" section. 

Enter a save location for the server projects. 

Under "Number of saved revisions:" select how many project versions should 
be available as "rollback".  

3. Click "Install service". 

 

Figure 2-3: TIA Project-Server - Configuration 
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Note For the project management you need enough free storage space on the project 
server, depending on the size of the project and the number of project revisions. 

 

4. Start the new project server by clicking on the "Start service" button in the 
"Server status" area. 

Figure 2-4: TIA Project-Server - Configuration 

 

The project server is now configured and started. 

 

Figure 2-5: TIA Project-Server - Configuration 
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2.2.5 TIA Project-Server Administration 

2.2.5.1 Add a new server connection 

Add a new server with the graphical tool "TIA Project-Server V17 - Administration".  

Follow the steps below: 

1. Open the Start menu by clicking "Start > All Programs > Siemens Automation". 
Click on "TIA Project-Server V17 - Administration" to launch the administration 
tool. 

2. Add a connection to the desired project server by clicking "Add server". In the 
"Add server" dialog, enter the server administration data. The data can be 
found in the "Configuration Tool" (see Figure 2-5).  

3. Click "Add" to add the server connection. 

Figure 2-6: TIA Project-Server - Administration 

 

The new server connection appears in the left pane of the Administration Tool. 

4. Click on the triangle of the new server connection to activate the connection. 
Confirm the certificate by clicking "OK". 
You can check the authenticity of the certificate by comparing the fingerprint of 
the displayed certificate with the certificate that was generated during 
configuration. The fingerprint can be found in the "Server status" area under 
"Client info" (see Figure 2-5). 

Figure 2-7: TIA Project-Server - Administration 
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2.2.5.2 Assign access permissions for project server and server projects 

Under "User Management", you will define the permissions for working with project 
server connections, with server projects and with local sessions. The permissions 
concept is based on Windows access permissions for folders and files. 

Follow the steps below: 

1. Open the Start menu by clicking "Start > All Programs > Siemens Automation". 
Click on "TIA Project-Server V17 - Administration" to launch the administration 
tool. 

2. Click on "User Management". The "User Management" opens and displays the 
possible settings on the right side. 

3. You use "User Management" to define explicit personal authorizations for the 
following roles: 

– Manager (full access) 

– Contributor (partial access, no deletion) 

– Member (read permission) 

Double-click "<Add...> to add new users for the displayed roles. 

Figure 2-8: TIA Project-Server - Administration 

 

4. In the "Select Users or Groups" dialog, enter the user, e.g. "MultiuserClient1", 
and click "OK".  
To check your entry, click on "Check Names". 

Figure 2-9: "Select Users or Groups" dialog box 

 

The new user is displayed in his or her permission group. 
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5. Repeat steps 3 and 4 to grant access permissions to other users. 

 

Note As an administrator, it is preferable to add user groups rather than individual 
users to the user administration. 

 

Note Further information about the TIA Project-Server can be found in the FAQ "In TIA 
Portal V14 why can you not establish a connection to the Multiuser server?": 

https://support.industry.siemens.com/cs/ww/en/view/109741420 

 

Note You can move users up or down into other permission groups with the "Demote 
selected user" and "Promote selected user" buttons. 

 

2.2.6 Add project server connections in TIA Portal 

In order to work with the new server connection in TIA Portal, add the new server 
connection to TIA Portal on each client.  

Follow the steps below: 

1. In TIA Portal, select "Option > Settings > Project server". The "Connection" tab 
will open. An entry for the local server connection "Local Project Server" 
already exists. 

2. Add a server connection to the desired project server by clicking "Add server 
connection".  

 

Figure 2-10: Settings for project server connection 

 

 

https://support.industry.siemens.com/cs/ww/en/view/109741420
https://support.industry.siemens.com/cs/ww/en/view/109741420
https://support.industry.siemens.com/cs/ww/en/view/109741420
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3. In the "Add net project server connection" dialog, enter the data for 
administering the server. The data can be found in the "Configuration Tool" 
(see Figure 2-5).  

Click "Add" to add the server connection. 

 

Figure 2-11: "Add new project server connection" dialog 

 

 

The new project server connection is added and displayed. 

 

2.2.7 Create server project 

Note To create a multi-user server project from a single-user project, the single-user 
project must meet the following requirements: 

• The project already contains the complete hardware configuration with all 
connections. 

• The project already contains the required building blocks and is divided into 
technologically oriented groups. With this subdivision, a group can be 
assigned to the individual agents. 

• The project already contains all required project languages. 

 

If you want to work with Multiuser Engineering, create a multi-user server project 
on a client with the TIA Portal from a single-user project.  

Follow the steps below: 

1. In TIA Portal, click the menu command "Project > Project server > Manage 
server projects…". 

2. Select the desired server connection from the drop-down list.  
Confirm the certificate by clicking "OK". 

3. Click "<Add project to server>" to open a dialog and select the project. 
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Figure 2-12: "Manage server projects" dialog 

 

The dialog for selecting a project will open. 

4. Set the desired path to the single-user project in the dialog or navigate to the 
desired directory via the "..." button. Select the project you want to add as a 
multi-user server project.  

If the single-user project opens, then enter it automatically. 

5. Check the "Create local session" box if you want to create a local session for 
the newly added multi-user server project. 

6. Click "Add" to add the project as a new multi-user server project. 

 

Figure 2-13: Dialog "Add project to project server "<ServerName>"". 

 

The "Create local session" dialog opens. 
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7. Select the type for the local session, e.g. "Multiuser Engineering". 

Set the desired path for the local session in the dialog or navigate to the 
desired directory using the "..." button.  

Enter the name of the local session.  

If you want to open the new local session immediately, activate the option box 
"Open local session". 

8. Click "Create" to create the new session. 

Figure 2-14: "Create local session" dialog box 

 

The local session on the server is created and opened. 

2.2.8 Upgrade server projects 

To be able to use older multi-user server projects and local sessions with the 
current version of TIA Portal, these projects must first be upgraded. 

Follow the steps below: 

1. Before upgrading, save all existing local sessions in the multi-user server 
project. 

2. Save the multi-user server project as a single-user project. 

3. Upgrade the single-user project in TIA Portal. 

4. After the upgrade, create another multi-user server project from the single-user 
project. 

5. From the upgraded multi-user server project, create the local sessions again 
for all editors. 
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2.3 Working with local sessions 

In the local session you can select and edit almost all objects of STEP 7 and 
WinCC. 

 

Note A list of the objects for Multiuser Engineering supported by STEP 7 and WinCC 
can be found in the TIA Portal V17 online help or in the system manual 
"SIMATIC STEP 7 Basic/Professional V17 and SIMATIC WinCC V17": 

https://support.industry.siemens.com/cs/ww/en/view/109798671 

 

Note You can edit unsupported objects within a local session, but you cannot select 
them. Changes to unsupported objects are not transferred to the multi-user 
server project during check-in! 

 

Note Information about Startdrive and Multiuser can be found in the FAQ "Startdrive in 
TIA Portal V15, V15.1 or V16 with Option Multiuser Engineering". 

https://support.industry.siemens.com/cs/ww/en/view/109755940 

 

2.3.1 Assign tasks to agents 

To enable multiple editors to work together on a project smoothly, you first assign 
the objects to be edited to the individual editors. In this application example, the 
program is divided into groups. Each group is assigned to an agent as follows: 

• "Tank" group: Agent to " Client 1" 

• "Filling" group Agent to " Client 2" 

• CoolingHeating Group: Agent to " Client 2" 

 

Figure 2-15: Subdivision of the application example into groups 

 

  

https://support.industry.siemens.com/cs/ww/en/view/109798671
https://support.industry.siemens.com/cs/ww/en/view/109755940
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2.3.2 Creating a Local Session 

In order to work together on a multi-user server project, you must create local 
sessions on the respective computers (clients). When creating the multi-user 
server project, a local session for the client "MultiuserClient1" was already created.  

To create additional local sessions for users, proceed as follows: 

1. Add the project server connection to TIA Portal on the client (see 2.2.6). 

2. In TIA Portal, click the menu command "Project > Project server > Manage 
server projects…". 

3. Select the desired server from the drop-down list.  
If necessary, confirm the certificate by clicking "OK". 

4. Select the desired multi-user server project and click on 
"<Create new local session>". 

 

Figure 2-16: "Manage server projects" dialog 

 

The "Create local session" dialog opens. 

 

5. Select the type for the local session, e.g. "Multiuser Engineering". 

Set the desired path for the local session in the dialog or navigate to the 
desired directory using the "..." button.  

Enter the name of the local session.  

If you want to open the new local session immediately, activate the option box 
"Open local session". 
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6. Click "Create" to create the new session. 

 

Figure 2-17: "Create local session" dialog box 

 

The local session is created and opened. 

7. Repeat steps 1 through 6 to create local sessions for additional users on the 
respective machines (clients). 

 

Note With TIA Portal V17 or later, local sessions can also be on network drives. 
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2.3.3 Open local session 

You have the following options for opening a local session: 

• In TIA Portal via the associated multi-user server project 

• In TIA Portal via "Recently Used Projects" 

• When TIA Portal is closed, double-click the local session 
"<SessionName>.als17" with Windows Explorer. 

To open a local session via the associated multi-user server project, proceed as 
follows: 

1. In TIA Portal, click the menu command "Project > Project server > Manage 
server projects…". 

2. Select the desired server from the drop-down list.  

3. Select the desired local session.  

4. Click on the "Open" button. 

 

Figure 2-18: "Open Local Session" dialog 

 

The local session is opened and displayed. 
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2.3.4 Selecting Objects in the Local Session 

To enable you to edit the objects of the multi-user server project in parallel, each 
agent must select the objects assigned to him in his or her local session that he or 
she wants to edit. You can select the objects in your local session as follows: 

• As soon as you edit, copy, paste or delete an object in the local session in a 
TIA Portal editor, this object is automatically marked for check-in.  
This also applies to objects that the system creates in the background while 
the user is editing (e.g. system blocks and the like). 

• By clicking (1) on the displayed flags in the project tree. 

• Using the context menu command (2) "Mark objects for check-in": In this 
command, you can select several objects at the same time using multiple 
selection. 

 

Figure 2-19: Mark objects by clicking (1) or with context menu command (2) 

 

 

Note If you want to undo the selections, click the flag again. 

To prevent unwanted overwriting in the server project, avoid conflicts (red flags). 
The last status checked in is taken from the server project. 
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The flag of the selected object is displayed in color. The colors of the flags have the 
following meaning: 

Table 2-1: Flag color meanings 

Symbol Meaning 

 
The object can be marked for check-in. 

 
The object is selected in its own local session. 

 
The object is marked in another local session that belongs to the same multi-
user server project. 

 
Conflict: The object was selected in several local sessions at the same time. 

 Object is obsolete: If one of the above symbols are additionally marked with 
this overlay, the object no longer corresponds to the latest status of the server 
project and should absolutely be updated. 

 

The selected object can now be edited in the local session. 

 

2.3.5 Check in edited objects to the server project 

After you have edited the selected objects in the local session, you can check the 
changes into the server project. 

Follow the steps below: 

1. Click on the "Check-in" button in the multi-user toolbar. The multi-user editor 
then opens in the "Check-in" view and displays all objects marked in the local 
session that are transferred to the server project during check-in. 

2. Expand the displayed folders and check the items displayed and selected for 
check-in. 

3. Click on the "Show conflicts" button in the function bar to display any conflicts. 
Existing conflicts are displayed. Fix the conflicts displayed before check-in to 
avoid data loss or unwanted overwriting. If there are no conflicts, click this 
button again to return to the previous "Check In" view. 

4. The "Compile" checkbox is ticked by default. 

5. Select the compile type from the drop-down list.  
By compiling the pending changes before check-in, you ensure that you check 
in a project that is error-free and pass it on to other editors. 

6. Enter a comment on the change history to document the changes you made in 
the local session. 

7. Click on the "Start check-in" button to check the displayed objects into the 
multi-user server project. 
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Figure 2-20 Check in edited objects to the server project 

1

 

Before checking in, you can display the selected objects in the server project view 
together with the current contents of the server project. Activate the option "Show 
server project view" for this view (1). 

If you click this option, the server project view will open in the project tree before 
checking in. Click the "Save changes" button to check in your changes. If you click 
on the "Discard changes" button, your changes will be discarded and not applied to 
the server project. 

Figure 2-21: Server project view 

 

8. If you want to keep the markings in the local session after checking in, enable 
the Keep markings option. Click the OK button if you want to overwrite the local 
session with the more current contents of the server project.  
If you want to keep the local session, click the "Keep local session" button. 

Figure 2-22: "Check In" dialog 
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Result 

You receive a message that the check-in was completed successfully. 

Your local session is updated and opened after the successful check-in with the 
contents of the server project. 

• After the update, the local session contains all changes that have been 
checked in to the server project in the meantime. 

• If new objects were added to the server project, these objects are now also 
visible in your local session 

• If objects were deleted in the server project, these objects are no longer 
present in your local session. 

• Your markings in the local session will be automatically deleted if you did not 
select the Keep markings option. 

• The server connection will be released after check-in. The server status 
changes in the display within the function bar from "busy" to "available". 

2.3.6 Refresh local session 

Objects that other users change and check in are marked as "obsolete" in your 

local session on the object status icon with the icon  (see Table 2-1). If you want 
to transfer these objects from other users to your local session, refresh your local 
session.  

Follow the steps below: 

1. Click the "Refresh local session" button in the multi-user toolbar. The multi-
user editor opens in the Update view and displays all objects selected in your 
local session. The objects you selected are not overwritten when you update. 
Only objects that are not selected are synchronized with the contents of the 
server project. 

2. Expand the displayed folders and check the items displayed and selected for 
check-in. 

3. Click on the "Show conflicts" button in the function bar to display any conflicts. 
Existing conflicts are displayed. Fix the conflicts displayed before check-in to 
avoid data loss or unwanted overwriting. If there are no conflicts, click this 
button again to return to the previous Check In view. 

4. Click on the "Start refresh" button. 

5. You receive the message that the update was completed successfully. Click on 
"OK". If errors occur, you will receive an error message. 
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Figure 2-23: Refresh local session 

1

 

All "obsolete" objects in your local session have been updated. 

Result 

• All unselected objects in your local session have been updated.  

• The objects marked in your local session were not synchronized with the 
server status. 

If necessary, you can undo the local session refresh. After refreshing, click on the 
"Restore" button (1) in the multi-user editor. Your local session will then be restored 
with the contents from before the refresh. 

 

Note The "Restore" button is only active after a refresh and only as long as the 
contents of the local session can be restored to the previous state. 

 

2.3.7 Export a local session as a single-user project 

You can export a local session as a single-user project. This allows you to continue 
working on the project, even if there is no project server connection.  

If a local session is recognized as invalid on opening, you will be asked whether 
you want to export as a single-user project. This allows you to save the work 
results from the local session in a single-user project and continue using them.  

You can copy the objects changed in the single-user project and insert them later 
to the local session or to the server project. 

 

Note In order to export a local session as a single-user project, it must be closed. 
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To export a local session as a single-user project, proceed as follows: 

1. In TIA Portal, click the menu command "Project > Project server > Manage 
server projects…". 

2. Select the desired server from the drop-down list. 

3. Select the local session you want to export and click on the "Export as single-
user project..." command in the context menu. 

Figure 2-24: "Manage server projects" dialog 

 

In the following dialog, the name for the local session and the storage location are 
already preset.  

 

4. Enter the desired storage location under "Export to" or navigate to the desired 
storage location and click on "Export". The storage location (target directory) 
must be empty. 

Figure 2-25: "Export as single-user project" dialog 

 

The local session was exported successfully. 
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2.3.8 Working offline 

If you do not have an existing connection to the project server, you can also work 
"offline" with Multiuser Engineering if you have TIA Portal V15 or later. 

Enable the option in TIA Portal under "Project > Project server > Work offline". 

In the local session, the icon for the active server connection changes from a green 
circle to a light gray circle. 

When you switch back to "Work online", the system first checks whether there are 
any marking conflicts. Fix any existing conflicts. Then you can continue working 
online in the local session as usual. 

 

2.3.9 Editing library objects in local sessions 

Note Library objects should only be edited in the Server Project view, as this will not 
cause inconsistencies in the server project. 

Library objects from the project library can be edited in the local session, but this 
can lead to inconsistencies in the server project. Therefore it is recommended to 
only edit and save library objects from the server project view.  

Library objects can only be checked in or updated if they are released. 

Markings for check-in 

The individual library objects within the project library are marked for Multiuser 
Engineering in the same way as in the project tree (see 2.3.4).  

Figure 2-26: Selected library objects in the "Libraries" task card 

 

Checking in types and master copies 

You check changes to types and copy templates into the multi-user server project 
as well as all other objects within the local session (see 2.3.5). When you check in 
a type, all versions of the type are always checked in. 



2 Engineering 

 

Multiuser Engineering with TIA Project-Server 
Article ID: 109740141,    V1.6,    02/2023   31 
 

©
 S

ie
m

e
n
s
 A

G
 2

0
2
3
 A

ll 
ri

g
h
ts

 r
e
s
e
rv

e
d
 

Figure 2-27: Selected library objects in the "Libraries" task card 

 

Refreshing types and master copies 

If you update the local sessions (see 2.3.6), the library objects of the project library 
are updated at the same time. 

 

2.3.10 General rules 

When working in a team with Multiuser Engineering, you should note the following 
points: 

• Edit only the assigned objects / blocks. 

• Edit only selected objects  
With TIA Portal Multiuser Engineering V15 onward, objects will be selected 
automatically. 

• Do not make any changes to objects highlighted in yellow.  
Objects are edited by other editors. 

• Only check in compiled blocks. 
Under "Options > Settings > Multiuser > Compilation settings", activate the 
option "Compile before check-in". 

• Check changes into the server project only with a meaningful comment. 

• Perform the following enhancements/changes only in the server project: 

– Edit the hardware configuration. 

– Rename and move objects. 

– Edit global elements (e.g. PLC data types, DBs). 

– Perform library updates. 

– Change the block interfaces of blocks that exchange data with blocks of 
other agents. 

• Only work in the server project view if absolutely necessary. This will ensure 
that agents in local sessions are not unnecessarily locked out of the server. 
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2.4 Exclusive Engineering 

Working with an exclusive local session is no different than with single-user 
engineering. The server project is reserved exclusively for you; other users are 
denied write access as long as your exclusive local session exists. 

2.4.1 Create server project and exclusive local session 

The server project is created like a multi-user server project (see chapter 2.2.7). 
The exclusive local session is created similarly to a local session for Multiuser (see 
chapter 2.2.7 or chapter 2.3.2), except that you will choose the type "Exclusive 
Engineering" instead of "Multiuser Engineering". 

Figure 2-28 "Create local session" dialog box 

 

2.4.2 Apply edited objects to the server project 

Because you are working exclusively in the local session, you can edit all objects 
that are contained in your session.  

Once you have edited the objects in your exclusive local session, you can apply 
the changes to the server project as follows: 

1. Click "Apply changes" to apply the changes to the server project. 

Figure 2-29 Apply edited objects to the server project 
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2. In the following dialog, enter a comment on the revision history to document 
the changes you made in the local session. Then click "OK". 

Check the "Exit Exclusive Engineering" box when you wish to end the 
exclusive local session.  

Figure 2-30 "Apply changes" dialog 

 

Result 

The changes from the exclusive local session have been applied to the server 
project. 

A new revision of the server project has been created. 

Result if you have checked the "Exit Exclusive Engineering" box: 

• The block for the project server will be lifted, making the server available for 
other users. 

• The exclusive local session will then be deleted. 

 

Note You can terminate the closed exclusive local session in the "Manage server 
projects" dialog. To do this, right-click on the exclusive local session and select 
"Remove the server lock and delete the exclusive se…" in the context menu.  
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2.5 Working in the Server Project view  

You cannot select and check in all objects in the local session. In Multiuser 
Engineering, you can insert or edit unsupported objects directly in the server 
project view.  

2.5.1 Open Server Project View 

To open the Server Project view, proceed as follows: 

1. Open the desired local session. 

2. Click the "Open/close server project view" icon in the multi-user toolbar. 

 

Figure 2-31 Open and close server project view 

 

The Server Project view is displayed and the project can be changed in the Server 
Project view. Add a new block, for example. 

The icon  (see Table 2-2) in the multi-user toolbar indicates that the server 
project is locked in the local session. This means that you cannot check in any 
local session changes.  



2 Engineering 

 

Multiuser Engineering with TIA Project-Server 
Article ID: 109740141,    V1.6,    02/2023   35 
 

©
 S

ie
m

e
n
s
 A

G
 2

0
2
3
 A

ll 
ri

g
h
ts

 r
e
s
e
rv

e
d
 

Table 2-2: Server status legend 

Symbol Meaning 

 
Server status "connected" 

This icon indicates that the associated project server is available. 

 
Server status "locked" 

This symbol indicates that the associated project server is currently being 
used by a user and is therefore currently locked. 

 
Server status "not connected" 

This icon indicates that the associated project server is not connected. 

 
Server status "Work Offline" 

This symbol indicates that there is no connection to the project server because 
you have activated the "Work Offline" function. 

 This overlay symbol indicates that a newer version of the server project is 
available on the project server. 

 

2.5.2 Close Server Project view 

To close the server project view, click the Open/close server project view icon in 
the multi-user toolbar again.  

Click "Yes" in the following dialog to save your changes.  

The server project view is then closed. The  icon (see Table 2-2) in the multi-
user function bar indicates that the server is free again.  

To display the new block in the local sessions, refresh the local session (see 2.3.6). 
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2.6 Manage history for projects and revisions 

2.6.1 History display 

You can use the Administration Tool to display the history of the created projects. 

Follow the steps below: 

1. Click on "TIA Project-Server V17 - Administration" in the Start menu to launch 
the administration tool. 

2. Click on "History" on the left below the desired multi-user server project. The 
project history with the saved project revisions (versions) is displayed. 

3. Click on the "Show details" button. 

The history shows, for example, the check-in comment (1). In the "Changed 
objects" tab (2) you can see all changed objects for the selected revision. 

 

Figure 2-32 TIA Project-Server - Administration 

1
2
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2.6.2 Export server project as single-user project 

You can use the Administration Tool to export a revision as a single-user project. 

Follow the steps below: 

1. Click on "TIA Project-Server V17 - Administration" in the Start menu to launch 
the administration tool. 

2. Click on "History" on the left below the desired multi-user server project. The 
project history with the saved project revisions (versions) is displayed. 

3. Select the revision that you want to export as a single-user project. 

4. Click the "Export selected revision" button. 

 

Figure 2-33 TIA Project-Server - Administration 

 

5. In the following dialog, select the desired storage path and click on "OK". 
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2.6.3 Roll back session to selected revision 

With the Administration Tool you can roll back a selected session to the selected 
revision (version). 

Follow the steps below: 

1. Click on "TIA Project-Server V17 - Administration" in the Start menu to launch 
the administration tool. 

2. Click on "History" on the left below the desired multi-user server project. The 
project history with the saved project revisions (versions) is displayed. 

3. Select the revision to which you want to roll back. 

4. Click the "Roll back to the selected revision" button. 

 

Figure 2-34: TIA Project-Server - Administration 

 

A new line will be created to display the new revision. 

 

Note How many revisions are available as "rollback" is already set when configuring 
the project server. The number of revisions is unlimited. 
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2.6.4 Save revision 

To prevent revisions from being deleted automatically, you can save revisions 
worth preserving. 

Follow the steps below: 

1. Click on "TIA Project-Server V17 - Administration" in the Start menu to launch 
the administration tool. 

2. Click on "History" on the left below the desired multi-user server project. The 
project history with the saved project revisions (versions) is displayed. 

3. Select the revision you want to save. 

4. Click the "Save revision" button. 

5. If desired, enter a comment for the revision and confirm the prompt for saving 
the selected revision. 

 

Figure 2-35: TIA Project-Server - Administration 

 

 

The "Availability" column then displays a closed lock as an icon. 
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2.6.5 Export of the project history 

You can export the project history to XML for further evaluations. 

Follow the steps below: 

1. Click on "TIA Project-Server V17 - Administration" in the Start menu to launch 
the administration tool. 

2. Click on "History" on the left below the desired multi-user server project. The 
project history with the saved project revisions (versions) is displayed. 

3. Select the desired revisions. 

4. Click on the "Export history" button. 

Figure 2-36: TIA Project-Server - Administration 

 

5. Select the desired storage path in the following dialog and click on "Save" to 
save the desired history entries in XML format. 
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2.7 Migrate server projects from server A to server B 

If you use your own project server, for example when commissioning, then you can 
migrate the server projects to this commissioning server. The PG/PC of a user can 
in that case be used as a temporary project server. Before you migrate the server 
project, all changes in the local sessions must be checked into the server project. 

Proceed as follows to migrate a server project: 

1. Click on "TIA Project-Server V17 - Administration" in the Start menu to launch 
the administration tool. 

2. Select the server project you wish to migrate. 

3. Click "Export Server Project". 

Figure 2-37: TIA Project-Server - Administration 

 

4. In the subsequent dialog, select the save location for the export and click "OK".  

The server project and all its contents have been exported to the save location.  

5. Switch to your new project server. If you have no access to the export files with 
your new project server, copy them there. 

6. Click on "TIA Project-Server V17 - Administration" in the Start menu to launch 
the administration tool. 

7. Select the new project server. 

8. Click "Import Server Project". 

Figure 2-38: TIA Project-Server - Administration 

 

9. In the subsequent dialog, select the save location for the exported server 
project and click "OK". 

The server project will be opened and displayed with all its contents. 

10. Delete the server project on the original project server so that nobody 
continues to work on it by mistake. 
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3 Joint commissioning in a team 
The joint commissioning in the team can be carried out with or without multi-user 
commissioning. In order to ensure consistency between the server project and the 
PLC, we recommend commissioning with multi-user commissioning. Without multi-
user commissioning, the agents themselves must ensure consistency between the 
server project and the PLC.  

By loading a project status that is always synchronized both in the server project 
and on the PLC and is therefore consistent, fewer errors are passed on to other 
editors. 

The following figure on the left shows the manual workflow for downloading the 
server project and with the local session. On the right side the workflow with 
Multiuser Commissioning is shown. Here only the download has to be started in the 
local session. All further steps are performed automatically. 

 

Figure 3-1: Workflow for manual Download <> Download with Commissioning Mode 
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3.1 Commissioning with Multiuser Commissioning 

In commissioning mode, the changes are automatically checked into the server 
project when loading into the PLC from the local session, compiled and loaded 
from there into the device.  

The following figure shows the synchronization and loading via the server project.  

Figure 3-2: Synchronizing and loading via the server project 

 

With TIA Portal V16 or later, you have access to Multiuser Commissioning in 
"synchronous mode" and in "asynchronous mode".  

The following figure shows a comparison of the workflows in the two modes. 

 

Figure 3-3: Workflow in synchronous mode <> in asynchronous mode 
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3.1.1 Synchronous mode 

In synchronous mode, start the download to device and the download will be 
performed automatically. The local session will be automatically refreshed after 
downloading. You cannot continue your work in TIA Portal during the download 
process. Synchronous mode offers maximum synchronicity of data between local 
session, server project and PLC. 

3.1.2 Asynchronous mode 

In asynchronous mode, downloading to device is performed in the background by a 
second instance of TIA Portal. 

• This significantly reduces the times for downloading to device in asynchronous 
mode. 

• The local session is ready for editing again immediately after transferring the 
download. 

• As a user, you will only receive a notification when decisions and actions are 
needed for downloading to the device. If no user decisions are needed, the 
download to device will run asynchronously in the background. 

• If errors occur during compilation or downloading and user decisions are 
needed, you will be notified in the Multiuser Commissioning editor. 

Tips for working in asynchronous mode 

• If you use other logon information for the project server than you do for your 
Windows logon, you must add the logon information for the project server to 
the Windows Credential Manager. Refer to chapter 4.4, Credential Manager, 
for the procedure. 

Program modifications which require a safety password can be loaded in 
synchronous mode or in asynchronous mode. For loading in asynchronous 
mode, you will need a configured user administration (UMAC) with the 
permission "Edit safety-related project data" for the safety project.  
For additional information on user administration, refer to the manual "SIMATIC 
STEP 7 Basic/Professional V17 and SIMATIC WinCC V17" in the chapter 
entitled "Managing users and roles" at the following link: 
https://support.industry.siemens.com/cs/ww/en/view/109798671/14316533249
1 

Refer to the following link for a description of the "Edit safety-related project 
data" permission: 
https://support.industry.siemens.com/cs/ww/en/view/109798671/14214361626
7 

• Your local session will not be automatically refreshed after loading. Remember 
to refresh for local session at regular intervals in order to apply changes on the 
server project from other agents to your local session. 

• When working in asynchronous mode, renaming objects must only be 
performed in the Server Project view, otherwise the asynchronous download 
will be terminated. 

https://support.industry.siemens.com/cs/ww/en/view/109798671/143165332491
https://support.industry.siemens.com/cs/ww/en/view/109798671/143165332491
https://support.industry.siemens.com/cs/ww/en/view/109798671/142143616267
https://support.industry.siemens.com/cs/ww/en/view/109798671/142143616267
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3.1.3 Requirements 

As of TIA Portal V15.1, you can commission your project together as a team with 
Multiuser Commissioning. In order to use multi-user commissioning, the following 
prerequisites apply: 

1. All changes to the local sessions are checked in to the multi-user server 
project. 

2. All local sessions are updated. 

3. All selections in the local sessions have been removed. 

4. The multi-user server project was loaded into the PLC (see 3.1.4). 

5. The "Multiuser Commissioning" mode has been enabled in the "TIA Project-
Server V17 - Administration" tool (see 3.1.5). 
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3.1.4 Load multi-user server project 

Before multi-user commissioning can be used, the updated multi-user server 
project must be loaded into the PLC. 

To load the server project from your local session, proceed as follows: 

1. Open the Server Project View by clicking the Open/Close Server Project View 
button.  

2. In the server project view, select the PLC you want to load. 

3. Click the "Download to device" button. 

4. Exit the server project view by clicking the "Open/close server project view" 
button again. 

Figure 3-4: TIA Portal server project view 

 

Note If the server project is open, a download from the local sessions is not possible. 
The server status is displayed as locked in the local session. 
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3.1.5 Enable and disable Multiuser Commissioning 

The Multiuser Commissioning function is enabled and disabled with the graphical 
tool "TIA Project-Server V17 - Administration". 

Follow the steps below: 

1. Click on "TIA Project-Server V17 - Administration" in the Start menu to launch 
the administration tool. 

2. Select the server and the project you want to start. 

3. Click on the "Multiuser Commissioning" button to activate or deactivate the 
commissioning mode. 
The commissioning mode is activated when the button is highlighted in blue. 

4. The option "Check for different data before download (recommended)" is 
automatically activated. This option should only be deactivated when using 
SIMATIC S7-300 / S7-400 CPUs. 

 

Figure 3-5: TIA Project-Server - Administration 

 

 

If the "Multiuser Commissioning" mode is activated, this is indicated by the 
corresponding icon (see Figure 3-6) in all local sessions.  
If the "Multiuser Commissioning" mode is deactivated, the icon is displayed in grey. 

 

Figure 3-6: Local session project tree 
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3.1.6 Change commissioning mode in TIA Portal 

Default setting in TIA Portal 

In TIA Portal, you can switch between "synchronous mode" and "asynchronous 
mode" with "Options > Settings > Multiuser > Commissioning settings". When 
opening a local session, the commissioning mode set here will be applied. 

 

Figure 3-7: Commissioning settings 

 

Changeover in current session 

For the current session, you can also change modes with the button in the project 
tree. However, this change will only stay active until the session is closed again. If 
you reopen the local session, the default setting from TIA Portal will apply. 

The color of the button will tell you which commissioning mode is active. 
"Synchronous mode" appears in orange while "asynchronous mode" appears in 
blue. 

 

Figure 3-8: Mode change in the project tree 
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3.1.7 Working with local sessions 

The distribution of tasks among the editors and the local sessions can be retained 
from Multiuser Engineering. You continue to work in the local session in 
commissioning mode as usual. 

To put the programs and changes into operation in your local session, proceed as 
follows: 

1. Compile your changes. 

2. In the local session, select the changes that you want to load. 

3. Click the "Download to device" button. 
Confirm the download in the following dialog. 

 

Figure 3-9: Load program into PLC 

 

When loading into the PLC, the changes are automatically checked into the server 
project. 

After each download, a new revision is created on the project server. 

 

Note This procedure automatically ensures consistency between the server project 
and the PLC. 

In contrast to the manual workflow, the download in commissioning mode 
performs better while also maintaining consistency.  
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Project server not reachable during download 

If the project server cannot be reached when loading into the PLC, the following 
dialog will appear: 

Figure 3-10: Dialog: Project server not reachable during download 

1 2 3

 

The dialog offers the following options: 

1. You can attempt to reconnect to the server with the "Reconnect to server" 
button. 

2. You can download the program from the local session to the PLC with the 
"Download to device" button. The server project is not updated. 

Once the connection to the project server has been restored, you can check in 
your changes to the server project. 

3. Use the Cancel button to cancel the action. 

 

PLC not reachable during loading 

The following dialog will appear if the PLC cannot be reached while downloading: 

Figure 3-11: Dialog: PLC not reachable during loading 

1 2 3

 

The dialog offers the following options: 

1. With the button "Open server project view" you can try to establish the 
connection to the PLC via the server project. 

2. You can continue with the "OK" button. If no connection can still be 
established, a corresponding message is issued.  
The Server Project view opens. The server project is not updated. 

3. Use the Cancel button to cancel the action. 

 



3 Joint commissioning in a team 

 

Multiuser Engineering with TIA Project-Server 
Article ID: 109740141,    V1.6,    02/2023   51 
 

©
 S

ie
m

e
n
s
 A

G
 2

0
2
3
 A

ll 
ri

g
h
ts

 r
e
s
e
rv

e
d
 

3.1.8 General rules 

Working in a team with multi-user commissioning is basically subject to the same 
rules as engineering. You should also note the following points: 

• Compile your changes before loading. If errors occur during compiling, correct 
them beforehand. 

• Avoid uploading from the PLC. An upload from the PLC should only be carried 
out if changes are lost and only in the server project. 

 

3.2 Commissioning without Multiuser Commissioning 

Joint commissioning in a team is also possible without multi-user commissioning.  

3.2.1 Download about Server Project 

To download changes in the local session into the PLC via the server project, 
proceed as follows: 

1. Check your changes into the server project (see 2.3.5). 

2. Open the server project view (see 2.5.1). 

3. Download the server project to the PLC (see 3.1.4). 

4. Close the server project view (see 2.5.2). 

5. Refresh the local session (see 2.3.6). 

 

Note In the server project view only one user can work at a time. The server project is 
locked for all other users. 
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3.2.2 Download via local session 

To download changes in the local session directly into the PLC, proceed as follows: 

1. Check your changes into the server project (see 2.3.5). 

2. Refresh the local session (see 2.3.6). 

3. In the local session, select the changes that you want to load. 

4. Click the "Download to device" button. 
Confirm the download in the following dialog. 

 

Figure 3-12: Load program into PLC 

 

 

Note This procedure is only recommended if you work alone in the project and 
therefore do not have to pay attention to consistency. This means that you can 
load your project directly from the local session into the PLC without first 
updating the server project. 

Another exception to this procedure is when there are several PLCs in the 
project and each operator is working on only one PLC. 

If several editors are working on the project on one PLC, this procedure is not 
recommended because the consistency between the server project and the PLC 
is not automatically ensured. There is also the danger that when loading 
changes from the local session to the PLC, the changes of other users are 
overwritten. 
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4 Useful information 

4.1 Multiuser and Project Server function overview 

The following table is an overview of the functions of Multiuser and Project Server 
in the various versions. The functions listed are available in the specified version 
onward. 

Table 4-1 

 V14 V15 V15.1 V16 V17 

Auto-Marking      

Advanced Checkin Functions      

Change log & history      

Commissioning      

Async. Commissioning      

Exclusive Engineering      

Safety and Protected PLC 
download support for  
Async. Commissioning 

     

Openness Support & API for 
Multiuser functions 

     

 

4.2 Alternative solutions: "Command line tools" 

Chapters 2.2.4 and 2.2.5 describe the configuration and administration of the 
project server with graphical tools. The project server can also be configured and 
managed with the command line tools Multiuser Administrative Tools and Multiuser 
Power Tools. You need administrator rights to use the tools. 

4.2.1 Configure project server with "musrv" Administrative Tools 

Proceed as follows to configure the project server with the administrative tool: 

1. In Windows Explorer, navigate to the installation directory of the project server 
(default: "C:\Program Files\Siemens\Automation\Multiuser Server V17") and 
open the folder "Bin".  

2. Double-click on the file "start-musrv.bat" to open the administrative tool. 

3. Enter the desired command with the parameters into the command line and 
confirm the entry with the "Return" key. 

Example of input using the "Install" command: 

musrv install -r c:\ServerProjects -p 8735 -b https -h 

<certificatehash> 

 

Note Further information and an overview of the possible commands and their 
parameters can be found in the TIA Portal V17 online help or in the system 
manual "SIMATIC STEP 7 Basic/Professional V17 and SIMATIC WinCC V17": 

https://support.industry.siemens.com/cs/ww/en/view/109798671 

https://support.industry.siemens.com/cs/ww/en/view/109798671


4 Useful information 

 

Multiuser Engineering with TIA Project-Server 
Article ID: 109740141,    V1.6,    02/2023   54 
 

©
 S

ie
m

e
n
s
 A

G
 2

0
2
3
 A

ll 
ri

g
h
ts

 r
e
s
e
rv

e
d
 

4.2.2 Manage project server with "mupt" power tools 

Proceed as follows to manage the project server with this power tool: 

1. In Windows Explorer, navigate to the installation directory of the project server 
(default: "C:\Program Files\Siemens\Automation\Multiuser Server V17") and 
open the folder "Bin".  

2. Double-click on the file "start-mupt.bat" to open the power tool. 

3. Enter the desired command with the parameters into the command line and 
confirm the entry with the "Return" key. 

Example for the input with the command "Display project": 

mupt project show -s https://projectserver:8735/ 

 

Note Further information and an overview of the possible commands and their 
parameters can be found in the TIA Portal V17 online help or in the system 
manual "SIMATIC STEP 7 Basic/Professional V17 and SIMATIC WinCC V17": 

https://support.industry.siemens.com/cs/ww/en/view/109798671 

https://support.industry.siemens.com/cs/ww/en/view/109798671
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4.3 Backup concept 

So far, the current project state is usually only stored on the PG/PC of the 
individual programmer. With TIA Portal Multiuser, the project state is also backed 
up centrally on the project server.  

With the project history on the project server, project states can also be backed up 
and restored.  

Thanks to central project storage on the project server, a backup of the entire 
project server directory on one backup server is possible. The directory can also be 
backed up automatically using Windows functions. The project server can be 
restored by copying the directory contents from the backup server.  

However, you can also export single project revisions as single-user projects (see 
2.3.7), specifying the backup server as the target directory. The export can also be 
automated with the Multiuser Power Tools (command line tool). In order to restore 
the multi-user functionality of the exported project, a multi-user project must first be 
created.  

The following figure shows an overview of how you can back up your projects. 

 

Figure 4-1: Overview of project backups 
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4.4 Credential Manager 

Login credentials are required if you want to connect to a project server. 

If your current Windows user is a domain user with the required access rights, you 
can connect to the project server without entering your credentials. 

In other cases, you will need to enter your credentials each time you restart TIA 
Portal and connect to a project server. 

Figure 4-2 

 

You can save your credentials in the Windows Credential Manager so that you 
don't have to enter them each time. 

Follow the steps below: 

1. Open the Credential Manager "Control Panel > All Control Panel Items > 
Credential Manager". 

2. Click "Add a Windows credential". 

Figure 4-3 
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3. Enter the required project server address. You can find this in your TIA Portal 
settings, for example: "Options > Settings > Project server > Connection". 

4. Enter the login information and confirm your entries with "OK". 

Figure 4-4 

3

4

 

5. Repeat steps 2 to 4 for additional project servers. 
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4.5 Improving performance 

The following settings are available to increase performance when loading the 
program, refreshing the server, and creating local sessions with Multiuser.  

1. Project server network profiles and compression (Network profiles) 

2. Search in project 

4.5.1 Multiuser network profiles and compression 

Depending on the performance of your own network, you can choose between 
three different network profiles ("Fast", "Medium", "Slow").  For the network profiles 
("Medium" and "Slow"), compression for data transmission is activated. The 
following applies to the selection: 

• Fast: Network >= 1 Gbit / s 

• Medium, slow: Network < 1 Gbit / s 

In most cases the network profile "Medium" can be used. 

You will find this setting in TIA Portal under "Options > Settings > Project server > 
Network profiles". 

Figure 4-5: Project server settings 

 

 

Note Multiuser network profiles and compression can only be set with TIA Portal 
Multiuser Engineering V15.1 onwards. 

The change of network profile only becomes effective after a restart of the 
Multiuser client or the project server. 
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4.5.2 Search in project 

Disable the "Perform indexing for the search during check-in" option to improve 
check-in and update times. 

If you deactivate this option, indexing is not performed during check-in, but rather 
at other times.  

You can find this setting in TIA Portal under "Options > Settings > Multiuser > 
Search in project". 

Figure 4-6: Multiuser settings 
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4.6 Comparison of the local session with the server 
project 

For example, to display differences in a module in detail, you can compare your 
local session with the server project offline in the TIA Portal. 

To perform an offline/offline comparison, proceed as 

follows: 

1. Open the server project view (see 2.5.1). 

2. Select the PLC in the server project. 

3. Right-click to open the context menu. 

4. Select "Compare > Offline/Offline". 

→ The compare editor will open and the PLC will appear in the left pane. 

5. Drag the PLC from your local session to the drop area on the right. →. An 
automatic comparison is performed and the differences will be displayed. With 
the action "Overwrite" (1) you can transfer the block from the local session into 
the server project. However, this causes a conflict (red flag) in the local 
session. 

Figure 4-7 

1

 

6. Double-click on the block and both blocks will open next to each other. Here 
you can use the arrow (1) to copy individual sections to the left into the block of 
the server project. This will also cause a conflict (red flag) in the local session. 

Figure 4-8 

1
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5 Appendix 

5.1 Service and support 

Industry Online Support 

Do you have any questions or need assistance?  

Siemens Industry Online Support offers round the clock access to our entire 
service and support know-how and portfolio. 

The Industry Online Support is the central address for information about our 
products, solutions and services.  

Product information, manuals, downloads, FAQs, application examples and videos 
– all information is accessible with just a few mouse clicks:  

support.industry.siemens.com 
 

Technical Support 

The Technical Support of Siemens Industry provides you fast and competent 
support regarding all technical queries with numerous tailor-made offers  
– ranging from basic support to individual support contracts. Please send queries 
to Technical Support via Web form: 

siemens.com/SupportRequest 

SITRAIN – Digital Industry Academy 

We support you with our globally available training courses for industry with 
practical experience, innovative learning methods and a concept that’s tailored to 
the customer’s specific needs. 

For more information on our offered trainings and courses, as well as their 
locations and dates, refer to our web page: 

siemens.com/sitrain  

Service offer 

Our range of services includes the following:  

• Plant data services 

• Spare parts services 

• Repair services 

• On-site and maintenance services 

• Retrofitting and modernization services 

• Service programs and contracts 

You can find detailed information on our range of services in the service catalog 
web page: 

support.industry.siemens.com/cs/sc 

Industry Online Support app 

You will receive optimum support wherever you are with the "Siemens Industry 
Online Support" app. The app is available for iOS and Android:  

support.industry.siemens.com/cs/ww/en/sc/2067 

https://support.industry.siemens.com/
http://www.siemens.com/SupportRequest
https://www.siemens.com/sitrain
https://support.industry.siemens.com/cs/sc
https://support.industry.siemens.com/cs/ww/en/sc/2067
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5.2 Industry Mall 

 

The Siemens Industry Mall is the platform on which the entire siemens Industry 
product portfolio is accessible. From the selection of products to the order and the 
delivery tracking, the Industry Mall enables the complete purchasing processing – 
directly and independently of time and location: 
mall.industry.siemens.com 

 

5.3 Links and literature  

Table 5-1 

No. Subject 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ Link to the article 

https://support.industry.siemens.com/cs/ww/en/view/109740141 

\3\ SIMATIC STEP 7 Basic/Professional V17 and SIMATIC WinCC V17 system manual 

https://support.industry.siemens.com/cs/ww/en/view/109798671 

\4\ FAQ: Startdrive in TIA Portal V17 with Option Multiuser Engineering 

https://support.industry.siemens.com/cs/ww/en/view/109755940 

\5\ FAQ: In TIA Portal V14 why can you not establish a connection to the Multiuser 
server? 

https://support.industry.siemens.com/cs/ww/en/view/109741420 

 

 

5.4 Change documentation 

Table 5-2 

Version Date Modification 

V1.1 02/2017  First version 

V1.2 08/2017 Information about Multiuser license added 

V1.3 06/2018 Update to TIA Portal Multiuser Engineering V15 

V1.4 06/2019 Update to TIA Portal Multiuser Engineering V15.1 

V1.5 09/2021 Update to TIA Portal Multiuser Engineering V17 

V1.6 02/2023 Name harmonization 

 

https://mall.industry.siemens.com/
https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/view/109740141
https://support.industry.siemens.com/cs/ww/en/view/109798671
https://support.industry.siemens.com/cs/ww/en/view/109755940
https://support.industry.siemens.com/cs/ww/en/view/109741420
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